To our customers,

Old Company Name in Catalogs and Other Documents

On April 1st, 2010, NEC Electronics Corporation merged with Renesas Technology Corporation, and Renesas Electronics Corporation took over all the business of both companies. Therefore, although the old company name remains in this document, it is a valid Renesas Electronics document. We appreciate your understanding.

Renesas Electronics website: http://www.renesas.com

April 1st, 2010
Renesas Electronics Corporation

Issued by: Renesas Electronics Corporation (http://www.renesas.com)
Send any inquiries to http://www.renesas.com/inquiry.
Notice

1. All information included in this document is current as of the date this document is issued. Such information, however, is subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful attention to additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website.

2. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights of third parties by or arising from the use of Renesas Electronics products or technical information described in this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.

3. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.

4. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for the incorporation of these circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from the use of these circuits, software, or information.

5. When exporting the products or technology described in this document, you should comply with the applicable export control laws and regulations and follow the procedures required by such laws and regulations. You should not use Renesas Electronics products or the technology described in this document for any purpose relating to military applications or use by the military, including but not limited to the development of weapons of mass destruction. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations.

6. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever for any damages incurred by you resulting from errors in or omissions from the information included herein.

7. Renesas Electronics products are classified according to the following three quality grades: “Standard”, “High Quality”, and “Specific”. The recommended applications for each Renesas Electronics product depend on the product’s quality grade, as indicated below. You must check the quality grade of each Renesas Electronics product before using it in a particular application. You may not use any Renesas Electronics product for any application categorized as “Specific” without the prior written consent of Renesas Electronics. Further, you may not use any Renesas Electronics product for any application for which it is not intended without the prior written consent of Renesas Electronics. Renesas Electronics shall not be in any way liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an application categorized as “Specific” or for which the product is not intended where you have failed to obtain the prior written consent of Renesas Electronics. The quality grade of each Renesas Electronics product is “Standard” unless otherwise expressly specified in a Renesas Electronics data sheets or data books, etc.

   “Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots.

   “High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-terrorism systems; safety equipment; and medical equipment not specifically designed for life support.

   “Specific”: Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or systems for life support (e.g. artificial life support devices or systems), surgical implantations, or healthcare intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life.

8. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or damages arising out of the use of Renesas Electronics products beyond such specified ranges.

9. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

11. This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.
Keep safety first in your circuit designs!

- Renesas Technology Corporation and Renesas Solutions Corporation put the maximum effort into making semiconductor products better and more reliable, but there is always the possibility that trouble may occur with them. Trouble with semiconductors may lead to personal injury, fire or property damage. Remember to give due consideration to safety when making your circuit designs, with appropriate measures such as (i) placement of substitutive, auxiliary circuits, (ii) use of nonflammable material or (iii) prevention against any malfunction or mishap.

Notes regarding these materials

- These materials are intended as a reference to assist our customers in the selection of the Renesas Technology product best suited to the customer's application; they do not convey any license under any intellectual property rights, or any other rights, belonging to Renesas Technology Corporation, Renesas Solutions Corporation or a third party.
- Renesas Technology Corporation and Renesas Solutions Corporation assume no responsibility for any damage, or infringement of any third-party's rights, originating in the use of any product data, diagrams, charts, programs, algorithms, or circuit application examples contained in these materials.
- All information contained in these materials, including product data, diagrams, charts, programs and algorithms represents information on products at the time of publication of these materials, and are subject to change by Renesas Technology Corporation and Renesas Solutions Corporation without notice due to product improvements or other reasons. It is therefore recommended that customers contact Renesas Technology Corporation, Renesas Solutions Corporation or an authorized Renesas Technology product distributor for the latest product information before purchasing a product listed herein. The information described here may contain technical inaccuracies or typographical errors. Renesas Technology Corporation and Renesas Solutions Corporation assume no responsibility for any damage, liability, or other loss rising from these inaccuracies or errors. Please also pay attention to information published by Renesas Technology Corporation and Renesas Solutions Corporation by various means, including the Renesas home page (http://www.renesas.com).
- When using any or all of the information contained in these materials, including product data, diagrams, charts, programs, and algorithms, please be sure to evaluate all information as a total system before making a final decision on the applicability of the information and products. Renesas Technology Corporation and Renesas Solutions Corporation assume no responsibility for any damage, liability or other loss resulting from the information contained herein.
- Renesas Technology semiconductors are not designed or manufactured for use in a device or system that is used under circumstances in which human life is potentially at stake. Please contact Renesas Technology Corporation, Renesas Solutions Corporation or an authorized Renesas Technology product distributor when considering the use of a product contained herein for any specific purposes, such as apparatus or systems for transportation, vehicular, medical, aerospace, nuclear, or undersea repeater use.
- The prior written approval of Renesas Technology Corporation and Renesas Solutions Corporation is necessary to reprint or reproduce in whole or in part these materials.
- If these products or technologies are subject to the Japanese export control restrictions, they must be exported under a license from the Japanese government and cannot be imported into a country other than the approved destination. Any diversion or reexport contrary to the export control laws and regulations of Japan and/or the country of destination is prohibited.
- Please contact Renesas Technology Corporation or Renesas Solutions Corporation for further details on these materials or the products contained therein.

For inquiries about the contents of this document or product, fill in the text file the installer generates in the following directory and email to your local distributor.

YSUPPORT\Product-name\YSUPPORT.TXT

Renesas Tools Homepage  http://www.renesas.com/en/tools
Preface
The PDxxSIM I/O DLL kit is provided for the purpose of extending the functions of the M3T-PDxxSIM simulator debuggers. Microsoft Visual C++, a Windows application development environment available on the market, is needed to create I/O DLLs.
This user's manual shows the basic information necessary to use the PDxxSIM I/O DLL kit. For details about the language specifications of and the method for using Visual C++, refer to the user's manual included with your product or online help.

Supported simulator debuggers
The PDxxSIM I/O DLL kit cannot be used in all of the M3T-PDxxSIM simulator debuggers. For the simulator debuggers and their versions which can be run in conjunction with the PDxxSIM I/O DLL kit, refer to the release notes for the PDxxSIM I/O DLL kit in which they are detailed.

Rights to use
The rights to use the PDxxSIM I/O DLL kit come under the provisions of the Software License Agreement for the M3T-PDxxSIM simulator debuggers used. Please also be aware that the PDxxSIM I/O DLL kit can only be used in developing your product, and cannot be used for any other purpose.

Technical support
Please note that technical support for the PDxxSIM I/O DLL kit can be obtained by visiting our homepage (URL: http://www.renesas.com/en/tools/) at which latest information is available.
1. Abstract

I/O DLL means a Dynamic Link Library (DLL) that operates in conjunction with the simulator engine of the Simulator Debugger PDxxSIM (xx denotes the model name such as 308 or 30).
The Simulator Debugger when properly set up can load an I/O DLL, and can operate it synchronously with the timing at which the program executes one instruction, read/writes to memory or generates an interrupt.
This allows to debug the target program by simulating the operation of the microcomputer’s input/output ports or internal peripheral functions. This also makes data input/output and other linked operations with external tools possible.
Any desired I/O DLL can be created using C/C++ languages. Microsoft Visual C++, a Windows application development environment available on the market, is needed to create I/O DLLs.

2. Configuration

The I/O DLL accesses the simulator engine simxx.exe (xx denotes the model name such as 308 or 30) to obtain information on memory or register values, etc.
In turn, simxx.exe notifies the I/O DLL of various information including memory read/write information and the number of cycles in which the program executed each instruction.
The simulator debugger and the I/O DLL are configured in the manner shown below.
3. Method for Creating the I/O DLL

This chapter describes how to create I/O DLLs using Microsoft Visual C++ 6.0 (hereafter abbreviated VC++). For details on how to use VC++, see the VC++ user’s manual or help.

An I/O DLL may be created by making use of the I/O DLL sample project “IodllTemplate” which is included with the I/O DLL kit or newly from scratch. The IodllTemplate project is a VC++ template project provided for creating I/O DLLs.

3.1. Method for Using the IodllTemplate project

The following explains how to create I/O DLLs from the IodllTemplate project by using an I/O DLL for PD308SIM as an example. To create I/O DLLs for other simulator models, change the model name “308” described here with any desired model name (e.g., “30” or “32R”).

1. Choose “Open Workspace…” from the File menu of VC++. Open the project file “IodllTemplate.dsp” for the IodllTemplate project which is stored in a directory under the directory in which the I/O DLL package is installed (hereafter referred to as C:\YMTOOL\Iodll). “Samples¥Pdxxsim¥IodllTemplate”

2. Choose “Setting…” from the Project menu of VC++. Check path settings for the I/O DLL library files sim308.lib and IodllExpLib(d).lib which are specified in the “Object/library modules:” column of the category “General” on the Link tab. (The file locations must be specified using absolute or relative paths.) These library files are stored in the “Library” directory of C:\YMTOOL\Iodll.

   - If settings are made for Win32 Debug, specify IodllExpLibd.lib.

   ```
   Object/library modules:
   ...
   ...
   ```

   - If settings are made for Win32 Release, specify IodllExpLib.lib.

   ```
   Object/library modules:
   ...
   ...
   ```

3. Choose “Setting…” from the Project menu of VC++. Change the I/O DLL filename “IodllTemplate.dll” which is specified in the “Output file name:” column of the category “General” on the Link tab to another filename you want (extension “.dll”) so that the I/O DLL output destination is the directory in which you installed PD308SIM (hereafter referred to as C:\YMTOOL\PD308SIM).

   ```
   Output file name:
   C:\YMTOOL\PD308SIM\sample.dll
   ```

4. Open infunc¥iofunc.cpp, then write the code for simulation. The infunc¥iofunc.cpp has implemented in it the functions called from sim308.exe. Use a function that accesses sim308.exe in the desired function as you write the code for simulation.

5. When you build, an I/O DLL (sample.dll) is created under the directory C:\YMTOOL\PD308SIM.
3.2. Method for Creating the new I/O DLL

To create a new I/O DLL without using the IodlITemplate project, follow the procedure described below.

1. Choose “New…” from the File menu of VC++. Then create a new project with settings shown below.
   - Select MFC AppWizard (dll) on the Projects tab.
   - Set any project name and location. (Example: “sample” project)
   - Choose “Create new workspace”.
   - Check Win32 in the “Platforms:”.
   - Click the [OK]->[Close].
2. Choose “Setting…” from the Project menu of VC++ and enter the settings described below.
   • Select the C/C++ tab and add a definition “IODLL_EXPORTS” to the “Preprocessor definitions:”
     column of the category “General.”

   ![Preprocessor definitions:]
   
   \[\text{\_WIN\_DLL\_AF\_DLL\_MECS\_US\_DLL\_IODLL\_EXPORTS} \]

   • Select the Link tab and specify the I/O DLL library files sim308.lib and IodllExpLib(d).lib using
     absolute or relative paths in the “Object/library modules:” column of the category “General.” These
     library files are stored in the “Library” directory of C:\YMTOOL\Iodll.
     
     - If settings are made for Win32 Debug, specify IodllExpLibd.lib.

   ![Object/library modules:]
   
   \[\text{\_\_\_\_Library\_Sim308.lib \_\_\_\_Library\_Iodll\_ExpLib\_d.lib} \]

     - If settings are made for Win32 Release, specify IodllExpLib.lib.

   ![Object/library modules:]
   
   \[\text{\_\_\_\_Library\_Sim308.lib \_\_\_\_Library\_Iodll\_ExpLib\_lib} \]

3. Choose “Setting…” from the Project menu of VC++. Set the “Output file name:” column of the
   category “General” on the Link tab so that the I/O DLL output destination is the directory
   C:\YMTOOL\PD308SIM.

   ![Output file name]
   
   \[\text{C:\YMTOOL\PD308SIM\sample.dll} \]

4. Copy iofunc.cpp and iofunc.h from the “iofunc” directory of the IodllTemplate project into any
   directory of the new project you’ve created, and add them to the project following the procedure
   described below.

   • Choose “Add To Project” – “Files…” from the Project menu of VC++, select iofunc.cpp from the
     ensuing list, and click OK.

5. Open iofunc.h and change the main header file specification for the application included in it to the
   new main header filename you’ve created.

   Example:  \#include \"..\IodllTemplate.h\" -> \#include \"..\sample.h\"

6. Open iofunc.cpp, then write the code for simulation.

7. When you build, an I/O DLL (sample.dll) is created under the directory C:\YMTOOL\PD308SIM.
4. Method for Using the I/O DLL

This chapter describes how to use an I/O DLL in the PDxxSIM after loading it.

Before you can use an I/O DLL, you must first register it to simxx.exe.

If simxx.exe has an I/O DLL registered in it when you start, it loads the registered I/O DLL before starting simulation.

The following explains how to use an I/O DLL after registering it to the PDxxSIM by using PD308SIM as an example. To use I/O DLLs for other simulator models, change the model name “308” described here with any desired model name (e.g., “30” or “32R”).

1. Copy the I/O DLL file (.dll file) you want to use into C:¥MTOOL¥PD308SIM.

2. Register the I/O DLL to simxx.exe. To do this, write the I/O DLL filename in sim308.exe’s environment setup file “sim308.ini.”

   The sim308.ini file exists in C:¥MTOOL¥PD308SIM. However, this file is nonexistent if you have never started PD308SIM since you installed it. In that case, this file needs to be newly created using an editor.

3. In the sim308.ini file, create a [DLLNAME] section and write an I/O DLL filename after “IODLL=,” with the extension “.dll” removed as shown below.

   Example: When an I/O DLL file name is "Sample.dll".

   [DLLNAME]
   IODLL=Sample

4. When you start PD308SIM, the I/O DLL is loaded.

   If you do not use the I/O DLL, delete the description of the [DLLNAME] section that you created in the sim308.ini file before starting PD308SIM.

   [DLLNAME] <- Delete
   IODLL=Sample <- Delete
5. Method for Debugging the I/O DLL

This chapter describes how to debug the I/O DLL you’ve created.

To debug the I/O DLL in VC++, you need to change settings of the I/O DLL project. The following shows the contents of changes you need to make by using the case of debugging an I/O DLL for PD3008SIM as an example. To debug I/O DLLs for other simulator models, change the model name “308” described here with any desired model name (e.g., “30” or “32R”).

1. Following the procedure described in the preceding section, register the I/O DLL to make it usable.
2. Choose “Setting...” from the Project menu of VC++. Set the “Output file name:” column of the category “General” on the Link tab so that the I/O DLL output destination is the directory C:\YMTOOL\PD308SIM.

![Output file name]

3. Choose “Setting...” from the Project menu of VC++. Set up the “Executable for debug session:” column on the Debug tab so that the simulator engine executable file “sim308.exe” stored in C:\YMTOOL\PD308SIM becomes the debug-time executable file.

![Executable for debug session]

4. After you finished setting up, choose “Start Debug” -- “Go” from the Build menu of VC++ to start debugging. The dialog box shown below will appear.

Because the I/O DLL can be debugged, click OK to continue.

![Microsoft Developer Studio]

5. To debug the I/O DLL, start PD308SIM after the simulator engine sim308.exe has started up. (After sim308.exe started up, it is registered (displayed) in the Windows system tray. So you can see that sim308.exe is up and running before you start PD308SIM.)

For details the debugging function of VC++, see the VC++ user’s manual or help.
6. Functions that Send Information to the I/O DLL

This chapter describes specifications of the functions that send information on the simulator engine side to the I/O DLL.

These functions are implemented in the I/O DLL project’s source file “iofunciofunc.cpp.” The simulator engine simxx.exe calls these functions as it sends information to the I/O DLL. Make sure codes for simulation are written in these functions.

<table>
<thead>
<tr>
<th>Function name</th>
<th>Abstract</th>
</tr>
</thead>
<tbody>
<tr>
<td>NotifyStepCycle</td>
<td>Notifies the number of execution cycles each time an instruction is executed.</td>
</tr>
<tr>
<td>NotifyPreExecutionPC</td>
<td>Notifies the current PC value immediately before executing an instruction.</td>
</tr>
<tr>
<td>NotifyReset</td>
<td>Notifies that the target program was reset.</td>
</tr>
<tr>
<td>NotifyStart</td>
<td>Notifies that the simulator engine was started.</td>
</tr>
<tr>
<td>NotifyEnd</td>
<td>Notifies that the simulator engine was terminated.</td>
</tr>
<tr>
<td>NotifyInterrupt</td>
<td>Notifies the vector number (vector address) for an interrupt when that interrupt was generated.</td>
</tr>
<tr>
<td>NotifyPreReadMemory</td>
<td>Notifies the read address and data length immediately before reading from memory when a memory read from the target program occurred.</td>
</tr>
<tr>
<td>NotifyPostWriteMemory</td>
<td>Notifies the write address, data length and data value after data was written from the target program to memory.</td>
</tr>
</tbody>
</table>

Below shows a specification of the function.

- **Notifies the number of execution cycles an instruction is executed**
  
  Function name: void NotifyStepCycle(int cycle)
  
  Parameter: int cycle The number of the executed cycles.
  
  Return value: None
  
  Functions: Notifies the number of execution cycles each time an instruction is executed.

- **Notifies the current PC value before executing an instruction**
  
  Function name: void NotifyPreExecutionPC(unsigned long address)
  
  Parameter: unsigned long address PC value before executing
  
  Return value: None
  
  Functions: Notifies the current PC value immediately before executing an instruction.

- **Notifies the reset**
  
  Function name: void NotifyReset(void)
  
  Parameter: None
  
  Return value: None
  
  Functions: Notifies that the target program was reset.
• **Notifies the start of simulator engine**
  
  Function name: `void NotifyStart(void)`
  
  Parameter: None
  
  Return value: None
  
  Functions: Notifies that the simulator engine was started.

• **Notifies the terminate of simulator engine**

  Function name: `void NotifyEnd(void)`
  
  Parameter: None
  
  Return value: None
  
  Functions: Notifies that the simulator engine was terminated.

• **Notifies the generate of interrupt**

  Function name: `void NotifyInterrupt(unsigned long vec)`
  
  Parameter: `unsigned long vec` Vector number. (Vector address)
  
  PD308SIM, PD30SIM --- Vector number.
  
  PD32RSIM --- EIT vector entry. (Only 0x00000080)
  
  Return value: None
  
  Functions: Notifies the vector number (vector address) for an interrupt when that interrupt was generated.

• **Notifies immediately before reading from memory**

  Function name: `void NotifyPreReadMemory(unsigned long address, int length)`
  
  Parameter: `unsigned long address` Memory address.
  
  `int length` Data length of memory data.
  
  1 1 byte
  
  2 2 byte
  
  3 3 byte
  
  4 4 byte
  
  Return value: None
  
  Functions: Notifies the read address and data length immediately before reading from memory when a memory read from the target program occurred.
**Notifies after data was written from memory**

Function name: void NotifyPostWriteMemory(unsigned long address, int length, unsigned long data)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>unsigned long address</td>
<td>Memory address.</td>
</tr>
<tr>
<td>int length</td>
<td>Data length of memory data.</td>
</tr>
<tr>
<td>1</td>
<td>1 byte</td>
</tr>
<tr>
<td>2</td>
<td>2 byte</td>
</tr>
<tr>
<td>3</td>
<td>3 byte</td>
</tr>
<tr>
<td>4</td>
<td>4 byte</td>
</tr>
<tr>
<td>unsigned long data</td>
<td>Memory data value.</td>
</tr>
</tbody>
</table>

Return value: None

Functions: Notifies the write address, data length and data value after data was written from the target program to memory.
The following shows an example of how to write the above functions. The shaded sections in this example are the template part of the above functions that are implemented in the iofunc.cpp file.

```c
void NotifyStepCycle(int cycle)
{
    unsigned longtabsrData, ta0Data, ta0icData;

    if (sCountFlag === FALSE) { // Check on count beginning flag.
        return;
    }
    RequestGetMemory(TABSR, 1, &tabsrData);
    if ((tabsrData & 0x01) == 0x01) { // Check on count beginning flag.
        sCountCycle += cycle;
        RequestGetMemory(TA0, 2, &ta0Data);
        if (sCountCycle >= ta0Data + 1) { // Count down of counter.
            RequestGetMemory(TAOIC, 1, &ta0icData);
            RequestInterrupt(TA0INT, ta0icData & 0x7);
            // Generation of timer A0 interrupt.
            sCountCycle = 0;
        }
    }
    return;
}

void NotifyPreExecutionPC(unsigned long address)
{
    return;
}

void NotifyPostWriteMemory(unsigned long address, int length)
{
    if (address == TABSR) {
        if ((data & 0x01) == 0x01) { // Check on count beginning flag.
            sCountFlag = TRUE;
        }
    }
    return;
}
```
Functions that Get Information from simxx.exe

This chapter describes specifications of the functions that get information on the simulator engine side from the I/O DLL.

These functions are implemented on the simxx.exe side. The I/O DLL calls these functions to get information from the simulator engine. Use these functions to write codes for simulation within the functions implemented in the I/O DLL project’s source file “iofunc¥iofunc.cpp.”

<table>
<thead>
<tr>
<th>Function name</th>
<th>Abstract</th>
</tr>
</thead>
<tbody>
<tr>
<td>RequestGetMemory</td>
<td>Gets memory data from the specified address.</td>
</tr>
<tr>
<td>RequestPutMemory</td>
<td>Sets memory data at the specified address.</td>
</tr>
<tr>
<td>RequestGetRegister</td>
<td>Gets a value from the specified register.</td>
</tr>
<tr>
<td>RequestPutRegister</td>
<td>Sets a value in the specified register.</td>
</tr>
<tr>
<td>RequestInterrupt</td>
<td>Generates a specified interrupt.</td>
</tr>
<tr>
<td>RequestInterruptStatus</td>
<td>Gets the status of generated interrupts.</td>
</tr>
<tr>
<td>RequestTotalCycle</td>
<td>Inspects a total number of current execution cycles.</td>
</tr>
<tr>
<td>RequestInstructionNum</td>
<td>Inspects a total number of currently executed instructions.</td>
</tr>
<tr>
<td>RequestStop</td>
<td>Causes the target program to stop running.</td>
</tr>
<tr>
<td>RequestErrorNum</td>
<td>Gets an error number when an error occurred in the immediately preceding function that was executed.</td>
</tr>
</tbody>
</table>

Below shows a specification of the function.

- **Gets memory data**

  Function name: int RequestGetMemory(unsigned long address, int length, unsigned long * data)

  Parameter:   
  
  unsigned long address    Memory address.  
  int length    Data length of memory data.  
  
  1 1 byte  
  2 2 byte  
  3 3 byte  
  4 4 byte  

  unsigned long * data    Memory data storage area.  

  Return value:   
  
  int status  
  
  TRUE  Succeeded.  
  FALSE  Error.  

  Functions:   
  
  Gets memory data from the specified address.  
  
  The read access information performed by this function is not reflected in the virtual port input and I/O script facilities.
Sets memory data

Function name: int RequestPutMemory(unsigned long address, int length, unsigned long data)

Parameter: unsigned long address Memory address.

Parameter: int length Data length of memory data.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1 byte</td>
</tr>
<tr>
<td>2</td>
<td>2 byte</td>
</tr>
<tr>
<td>3</td>
<td>3 byte</td>
</tr>
<tr>
<td>4</td>
<td>4 byte</td>
</tr>
</tbody>
</table>

unsigned long data Memory data.

Return value: int status

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE</td>
<td>Succeeded.</td>
</tr>
<tr>
<td>FALSE</td>
<td>Error.</td>
</tr>
</tbody>
</table>

Functions: Sets memory data at the specified address.

The write access information performed by this function is not reflected in the GUI output, virtual port output and I/O script facilities.
● Gets register value

Function name: int RequestGetRegister(int regNo, unsigned long * regValue)

Parameter: int regNo Register number.

For register numbers, see the header file “iofunc¥iofunc.h” that is included in the
I/O DLL sample program. Register numbers are defined in this file.

Example: Definition for PD308SIM.

<table>
<thead>
<tr>
<th>regNo</th>
<th>Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>REG_Rx_F</td>
<td>Bank0 Rx registers. (x = 0 to 3)</td>
</tr>
<tr>
<td>REG_RxH_F</td>
<td>High-order 8 bits of the Bank0 Rx register. (x = 0 to 1)</td>
</tr>
<tr>
<td>REG_RxL_F</td>
<td>Low-order 8 bits of the Bank0 Rx register. (x = 0 to 1)</td>
</tr>
<tr>
<td>REG_Ax_F</td>
<td>Bank0 Ax registers. (x = 0 to 1)</td>
</tr>
<tr>
<td>REG_FB_F</td>
<td>Bank0 FB register.</td>
</tr>
<tr>
<td>REG_SB_F</td>
<td>Bank0 SB register.</td>
</tr>
<tr>
<td>REG_Rx_R</td>
<td>Bank1 Rx registers. (x = 0 to 3)</td>
</tr>
<tr>
<td>REG_RxH_R</td>
<td>High-order 8 bits of the Bank1 Rx register. (x = 0 to 1)</td>
</tr>
<tr>
<td>REG_RxL_R</td>
<td>Low-order 8 bits of the Bank1 Rx register. (x = 0 to 1)</td>
</tr>
<tr>
<td>REG_Ax_R</td>
<td>Bank1 Ax register. (x = 0 to 1)</td>
</tr>
<tr>
<td>REG_FB_R</td>
<td>Bank1 FB register.</td>
</tr>
<tr>
<td>REG_SB_R</td>
<td>Bank1 SB register.</td>
</tr>
<tr>
<td>REG_Rx</td>
<td>Rx register indicated by the B flag. (x = 0 to 3)</td>
</tr>
<tr>
<td>REG_RxH</td>
<td>High-order 8 bits of the Rx register indicated by the B flag. (x = 0 to 1)</td>
</tr>
<tr>
<td>REG_RxL</td>
<td>Low-order 8 bits of the Rx register indicated by the B flag. (x = 0 to 1)</td>
</tr>
<tr>
<td>REG_Ax</td>
<td>Ax register indicated by the B flag. (x = 0 to 1)</td>
</tr>
<tr>
<td>REG_FB</td>
<td>FB register indicated by the B flag.</td>
</tr>
<tr>
<td>REG_SB</td>
<td>SB register indicated by the B flag.</td>
</tr>
<tr>
<td>REG_USP</td>
<td>USP register.</td>
</tr>
<tr>
<td>REG_ISP</td>
<td>ISP register.</td>
</tr>
<tr>
<td>REG_FLG</td>
<td>FLG register.</td>
</tr>
<tr>
<td>REG_PC</td>
<td>Program counter.</td>
</tr>
<tr>
<td>REG_INTB</td>
<td>INTB register.</td>
</tr>
<tr>
<td>REG_SVF</td>
<td>SVF register.</td>
</tr>
<tr>
<td>REG_SVP</td>
<td>SVP register.</td>
</tr>
<tr>
<td>REG_VCT</td>
<td>VCT register.</td>
</tr>
<tr>
<td>REG_DMDx</td>
<td>DMDx registers. (x = 0 to 1)</td>
</tr>
<tr>
<td>REG_DCTX</td>
<td>DCTX registers. (x = 0 to 1)</td>
</tr>
<tr>
<td>REG_DRCx</td>
<td>DRCx registers. (x = 0 to 1)</td>
</tr>
<tr>
<td>REG_DMAx</td>
<td>DMAx registers. (x = 0 to 1)</td>
</tr>
<tr>
<td>REG_DSx</td>
<td>DSx registers. (x = 0 to 1)</td>
</tr>
<tr>
<td>REG_DRx</td>
<td>DRx registers. (x = 0 to 1)</td>
</tr>
</tbody>
</table>

Description example: To get the R0 register value in bank 0

RequestGetRegister( REG_R0_F, &regValue );

unsigned long * regValue Register value storage area.
Return value: int status

TRUE  Succeeded.
FALSE  Error.

Functions: Gets a value from the specified register.

- **Sets a register value**

  Function name: int RequestPutRegister(int regNo, unsigned long regValue)

  Parameter: int regNo  Register number.
             unsigned long regValue  Register value.

  Return value: int status

  TRUE  Succeeded.
  FALSE  Error.

  Functions: Sets a value in the specified register.

- **Generates a interrupt**

  Function name: int RequestInterrupt(unsigned long vec, int ipl)

  Parameter: unsigned long vec  Vector number. (Vector address)
             int ipl  Priority.

  For PD32RSIM, specify 0 because there is no interrupt priority.

  Return value: int status

  TRUE  Succeeded.
  FALSE  Error.

  Functions: Generates a specified interrupt.

- **Gets the status of generated interrupts**

  Function name: int RequestInterruptStatus(unsigned long * vec)

  Parameter: unsigned long * vec  Vector number. (Vector address)

  Return value: int happen  Generation status of interrupt.

  TRUE  Generated. Vector number are stored in vec.
  FALSE  Un-generated. Vec is indeterminate.

  Functions: Gets the status of generated interrupts.
- **Inspects a total number of execution cycles**
  
  Function name: void RequestTotalCycle(unsigned long * cycle)
  
  Parameter:  unsigned long * cycle  A total number of execution cycles.
  
  Return value: None
  
  Functions: Inspects a total number of current execution cycles.

- **Inspects a total number of executed instructions.**
  
  Function name: void RequestInstructionNum(unsigned long * inst)
  
  Parameter:  unsigned long * inst  A total number of currently executed instructions.
  
  Return value: None
  
  Functions: Inspects a total number of currently executed instructions.

- **Causes the target program to stop running**
  
  Function name: void RequestStop(void)
  
  Parameter:  None
  
  Return value: None
  
  Functions: Causes the target program to stop running.
● Gets error information

Function name: int RequestErrorNum(void)
Parameter: None
Return value: int errNum Error number.

<table>
<thead>
<tr>
<th>errNom</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>000</td>
<td>No error.</td>
</tr>
<tr>
<td>001</td>
<td>Address value is out of range.</td>
</tr>
<tr>
<td>002</td>
<td>Can't read/write, because there are no memory at that area.</td>
</tr>
<tr>
<td>003</td>
<td>Can't get enough memory.</td>
</tr>
<tr>
<td>004</td>
<td>Data size is out of range.</td>
</tr>
<tr>
<td>005</td>
<td>Can't access a specified address.</td>
</tr>
<tr>
<td>100</td>
<td>Description of register is illegal.</td>
</tr>
<tr>
<td>101</td>
<td>Data value is illegal.</td>
</tr>
<tr>
<td>200</td>
<td>Specified vector out of range.</td>
</tr>
<tr>
<td>201</td>
<td>Specified level of priority out of range.</td>
</tr>
<tr>
<td>202</td>
<td>Can't get enough memory.</td>
</tr>
</tbody>
</table>

Functions: Gets an error number when an error occurred in the immediately preceding function that was executed.

This function allows to get information on what error occurred when one of the following functions was called and its returned value was false.

- RequestGetMemory function
- RequestPutMemory function
- RequestGetRegister function
- RequestPutRegister function
- RequestInterrupt function

Use example:

```c
unsigned long data;
char str[5];
if ( RequestGetMemory( 0x800, 4, data ) == FALSE ) {
    sprintf( str, "%d", RequestErrorNum() );
    MessageBox( NULL, str, "Error number", MB_OK );
    // Display error number to message box.
}
```
The following shows an example of how to write the above functions. The shaded sections in this example are
the template part of the above functions that are implemented in the iofunc.cpp file.

```c
void NotifyPostWriteMemory(unsigned long address, int length, unsigned long data) {
    if (address == 0x3e0) {
        RequestGetRegister(REG_PC, &val); // Get PC Value.
        RequestPutMemory(0x800, 4, val); // Store PC value in 0x800 address.
    } else if (address == 0x3e1) {
        RequestPutRegister(REG_R0_F, data); // Store value in bank0 R0 register.
        RequestInterrupt(21, 7); // Generation of timer A0 interrupt.
    }
    return;
}
```
8. Specifying Target Program Symbols in the I/O DLL

This chapter describes how to specify target program symbols in the I/O DLL.

For the symbols defined in the target program to be specified in the I/O DLL, it is necessary that the symbol information be loaded into the I/O DLL using a symbol window which is an extension window of PDxxSIM.

The following explains the procedure for specifying target program symbols in the I/O DLL by using PD308SIM as an example. To use I/O DLLs for other simulator models, change the model name “308” described here with any desired model name (e.g., “30” or “32R”).

1. Register a symbol window to PD308SIM.
2. In the symbol window, output symbol information to a file.
3. Load the output file into the I/O DLL to register the symbol information.
4. Specify a symbol in the I/O DLL.

Each step is detailed below.

1. Register a symbol window to PD308SIM.

   Follow the procedure described below to register a symbol window to PD308SIM.

   (1) Copy the symbol window DLL file “SymbolWindow.dll” from the SymbolWindow\Pd308sim directory of C:\MTOOL\Iodll into C:\MTOOL\PD308SIM.

   (2) Open the PD308SIMDLL.DEF file existing in C:\MTOOL\PD308SIM by using an editor and increment the “WindowCount” counts for the [GENERAL] section.

   ```
   [GENERAL]
   ProductName=PD308SIM
   WindowCount=9  ->  WindowCount=10
   ```

   (3) Append the following contents to PD308SIMDLL.DEF.

   Contents:

   ```
   [Window9]
   Title=Symbol Window
   ID=50000
   Module=SymbolWindow
   Initialize=InitializeMDIChildFrame
   Create=CreateMDIChildFrame
   IsEnableToOpen=IsEnableToOpenMDIChildFrame
   GetOptionMenuID=GetOptionMenuID
   Append=1
   ```

   Make sure the number for the section name of the added section “[Window9]” that you set follows those of other windows.

   To remove the registered symbol window, restore the contents of PD308SIMDLL.DEF that you modified.
2. In the symbol window, output symbol information to a file.
   Below shows a process.
   
   (1) Start PD308SIM and when it has started up, choose [Add-In Windows] -> [Symbol Window] from the Optional Windows menu to open the symbol window.

   ![Symbol Window Image]

   (2) Download the target program into PD308SIM. After downloading, click the "Create Symbol List" button in the toolbar of the symbol window and select the file to which to output the symbol information.

   **Note:**

   Of the output symbol information, the information on local symbols is that of module files whose scopes are set in PD308SIM. (The term “scope” refers to the effective range of local symbols/ local labels.) To output information on the local symbols/ local labels included in other module files, change scope settings in PD308SIM. For details, see the description of the `scope` command in “PD308SIM Help,” the online help for PD308SIM.
(3) When symbol information is output to a file, the symbol information is displayed in the symbol window.

- The following are displayed in the contents.

  **Symbol type Symbol name = Symbol address**

  Symbol types are displayed in order of G_SYMBOL (global symbols), L_SYMBOL (local symbols), G_LABEL (global labels) and L_LABEL (local labels). No symbol types are displayed unless they exist in the target program.

- To search for symbols, click the “Search Symbol” button in the toolbar and enter the symbol name you want to search.

- If the target program is downloaded again, the symbol information being displayed in the symbol window is updated. In this case, symbol information is written over the file to which symbol information was previously output. To change symbol information output files, click the “Create Symbol List” button and specify a symbol file again.

  **Note:**

  Once a symbol information output file is selected (i.e., symbol information is displayed in the symbol window), the symbol information is automatically updated the next time you download the target program.

  If you download the target program while no symbol information is being displayed in the symbol window, no symbol information is updated. Therefore, click the “Create Symbol List” button to output symbol information.
3. Load the output file into the I/O DLL to register the symbol information.
   Below shows a process.
   - To register the symbol information to the I/O DLL, use the RegistrationSymbolList and FreeSymbolList functions. Below shows a specification of the function.

   **[Registration of symbol information]**

   Function name: \%BOOL RegistrationSymbolList(const char * pszFile)\
   Parameter: const char * pszFile Symbol file name.
   Specify the file with absolute path.
   Can’t use a network pathname.
   Return value: BOOL status
   TRUE Succeeded.
   FALSE Error.
   An error dialog is displayed if an error occurs.
   Below show the contents of the error.

<table>
<thead>
<tr>
<th>Error message</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>A symbol file can’t open.</td>
<td>The symbol file cannot be opened. Check whether the specified symbol file is correct and whether it exists.</td>
</tr>
<tr>
<td>Not enough memory to open a symbol file.</td>
<td>The symbol file cannot be opened for lack of memory. Check whether sufficient memory is available.</td>
</tr>
<tr>
<td>The format of the symbol file is wrong.</td>
<td>The symbol file has an invalid format. Create a symbol file correctly again.</td>
</tr>
</tbody>
</table>

   Functions: This function loads the created symbol file into the symbol window to register the symbol information. The symbol information registered by this function is retained in memory. Therefore, whenever the symbol information becomes unnecessary, call the FreeSymbolList function to delete the symbol information (to free up memory space).

   **[Delete of symbol information]**

   Function name: void FreeSymbolList(void)
   Parameter: None
   Return value: None
   Functions: Delete the symbol information (to free up memory space).
Below shows a use example.

```c
void NotifyReset(void)
{
    // When reset, load symbol information to register.
    RegistrationSymbolList("d:\\sample\\test.sym");

    return;
}

void NotifyEnd(void)
{
    // Delete the symbol information loaded into the I/O DLL when exiting PDxxSIM.
    FreeSymbolList();

    return;
}
```

**Note:**

The RegistrationSymbolList function registers only the symbol information included in one symbol file. If this function is called twice or more, it deletes the previous symbol information (to free up memory space) before registering new symbol information. If the same symbol file is specified, the function inspects the file’s timestamp and only when it has been updated, re-registers the symbol information.
4. Specify a symbol in the I/O DLL.
   Below shows a process.
   - To convert the symbol to a value in the I/O DLL, use the ChangeSymToVal function. Below shows a specification of the function.

   **[Convert value of the symbol]**

   **Function name:**
   ```c
   BOOL ConvertSymToVal(const char * pszSym, unsigned long * ulAddr,
                        int nType)
   ```

   **Parameter:**
   - `const char * pszSym` Symbol name.
   - `unsigned long * ulAddr` Pointer in which the converted symbol value is stored.
   - `int nType` Symbol types which are given priority when searched.
     - `TYPE_SYMBOL` Symbol.
     - `TYPE_LABEL` Label.

   **Return value:**
   - `BOOL status`
     - `TRUE` Succeeded.
     - `FALSE` A symbol isn’t found.

   **Functions:**
   This function searches for the corresponding value for the symbol and stores the found value in `ulAddr`. The table below shows what search priority will be assigned to each symbol type when specified by `nType`.

<table>
<thead>
<tr>
<th>Priority level</th>
<th>TYPE_SYMBOL</th>
<th>TYPE_LABEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>level 1</td>
<td>Local symbol</td>
<td>Local label</td>
</tr>
<tr>
<td>level 2</td>
<td>Global symbol</td>
<td>Global label</td>
</tr>
<tr>
<td>level 3</td>
<td>Local label</td>
<td>Local symbol</td>
</tr>
<tr>
<td>level 4</td>
<td>Global label</td>
<td>Global symbol</td>
</tr>
</tbody>
</table>

   **Attention:**
   For the symbol name to be specified for the `pszSym` parameter of the ConvertSymToVal function, be sure to use one that is displayed in the symbol window. For example, if the symbol name displayed in the symbol window is prefixed by an underbar as in the case of "_strl," the symbol name specified for the `pszSym` parameter must also be prefixed by an underbar.
Below shows a use example.

```c
void NotifyPreReadMemory(unsigned long address, int length)
{
    unsigned long s_addr;
    unsigned long data;

    // When the address 0x3e0 is read, store the value of the symbol “str1” in 0x3e0
    if ( address != 0x3e0 ) {
        return;
    }
    if ( ConvertSymToVal("_str1", &s_addr, TYPE_LABEL ) == FALSE ) {
        return;
    }
    RequestGetMemory(s_addr, length, &data);
    RequestPutMemory(address, length, data);
}
```

9. Notes

1. Changes of values input/output to or from memory using the I/O DLL cannot be referenced using the GUI output, virtual port input/output or I/O script facilities of PDxxSIM.
2. Only one I/O DLL can be specified in PDxxSIM. You cannot specify multiple I/O DLLs.